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Introduction 
VMD web page: http://www.ks.uiuc.edu/Research/vmd/
Documentation: http://www.ks.uiuc.edu/Research/vmd/current/docs.html

VMD is designed for modeling, visualization, and analysis of biological systems such as pro-
teins, nucleic acids, lipid bilayer assemblies, etc. It may be used to view more general mo-
lecules, as VMD can read standard Protein Data Bank (PDB) files and display the contained 
structure. VMD provides a wide variety of methods for rendering and coloring a molecule: 
simple points and lines, CPK spheres and cylinders, licorice bonds, backbone tubes and rib-
bons, cartoon drawings, and others. VMD can be used to animate and analyze the trajectory of 
a molecular dynamics (MD) simulation. In particular, VMD can act as a graphical front end 
for an external MD program by displaying and animating a molecule undergoing simulation 
on a remote computer.

1

http://www.ks.uiuc.edu/Research/vmd/current/docs.html
http://www.ks.uiuc.edu/Research/vmd/


Open VMD
Open the vmd program by typing vmd in the terminal and then go to Main menu → File 
→ New molecule → protein.pdb. The other way to see the protein is type in your ter-
minal commend line vmd protein.pdb, the result will be exactly the same. 

Figure 1. VMD windows

If you have the *psf file you can load this as well: 
1) highlight the structure in the Main menu
2) Mouse right click → Load Data Into Molecule → Browse the file → 

Load
3) Main menu → File → Load Data Into Molecule → Browse → Load 
4) vmd protein.pdb protein.psf

Three windows will open: VMD Main, VMD OpenGL and vmd console, as it's shown on 
Fig.1. 
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1. VMD Main
 

VMD Main (Fig. 2) is a VMD control, contains all sub-menus and also shows all molecules 
loaded. Each molecule has its ID,  T (Top), A (Active), D (Displayed) and F (Fixed) options, 
the information about number of atoms in the structure and the number of Frames loaded is 
given. To change T, A, D and F it is enough to double-click on them. Available values are on 
or off. If the trajectory is loaded this window allows the user to play, stop and pause the tra-
jectory, to select a particular frame number to be displayed, to chose if the trajectory should 
be played once or in the loop or change the speed (how fast the trajectory is played).

Figure 2. Vmd Main window.

2. VMD OpenGL 
 
The VMD OpenGL (Fig.3) is a main graphic window in which the molecule is displayed. In 
the VMD OpenGL display window the user can:

1) Rotate the protein. Press the mouse left key and rotate. If it does not work press r on 
the keyboard to switch on the rotation mode. Usually the rotation mode is a default

2) Translate the protein. To switch on the translation mode press t on the keyboard and 
then press the mouse left key and translate.

3) Scale the protein. To switch on the translation mode press s on the keyboard and then 
press the mouse left key and translate. Scaling is also possible in the rotation or trans-
lation mode by rolling the middle mouse button. Nevertheless it is more “coarse” scal-
ing.

4) Center the system on chosen atom. To switch on the center mode press c on the key-
board and then click left on the the chosen atom. If you come back to the rotation 
mode you will see that now the protein rotates around the chosen atom.

5) Select atom. To switch on the selection mode press 1 on the keyboard and then click 
on any atom. The green label containing residue name, number and atom type will ap-
pear (Fig. 3). Simultaneously additional information at vmd console will appear. This 
will state molecule id, trajectory frame, atom name, atom type, atom index, residue 
name, residue id, chain name, segment name and x, y, z coordinates of picked atom.
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6) Select and measure the distance between two atoms. To switch on the selection mode 
press 2 on the keyboard and then click on any two atoms. The green label for picked 
atoms and additionally the white label with the distance (in Å) will appear (Fig. 3). In-
formation about the picked atoms will appear also at vmd console window. 

7) Select and measure the angle between selected atoms. To switch on the selection 
mode press 3 on the keyboard and then click on any three atoms. The green label for 
picked atoms and additionally the yellow label with the angle (in degs) will appear 
(Fig. 3). Information about the picked atoms will appear also at vmd console window. 

8) Select and measure the dihedral between selected atoms. To switch on the selection 
mode press 4 on the keyboard and then click on any four atoms. The cyan green label 
for picked atoms and additionally the cyan label with the angle (in degs) will appear 
(Fig. 3). Information about the picked atoms will appear also at vmd console window. 

Note: to hide atom, bond, angle and dihedral labels it is enough to click again on appropriate 
atoms. The other option is to use  Main menu → Graphics → Labels – please see 
below.

For more options please see menu Mouse below. 

Figure 3. Vmd OpenGL window with atom, bond, angle and dihedral labels shown.
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3. vmd console 
 
It is an information window (Fig. 4). 

Figure 4. Vmd console window.

 

Menu File
All  options  are  available  once  any  loaded  mo-
lecule is highlighted.  New Molecule allows to 
load a new molecule, Load Data into Mo-
lecule allows to load appropriate data like psf 
file or the trajectory file. VMD will automatically 
recognize the file type to be loaded. If the traject-
ory  is  loaded  it  is  possible  to  load  each  frame 
(Stride 1),  each second frame (Stride  2)  10th 

frame (Stride 10) and so on. Loading can start and finish from any chosen frame (options 
First and Last, respectively) . Save Coordinates allows to save the entire trajectory 
using the same or any other format. It is possible to save trajectory only for selected atoms, 
user can save the entire trajectory, only a part or even a single frame (for example the last one
). By changing Stride it is possible to save for example every 10th frame, every 100th frame 
etc. By choosing Load State option from menu File the user can load previously saved 
VMD state. For example if the user have created a lot of selections, graphical representations,  
have loaded many molecules and wish to not repeat that next time can  Save State and 
later Load State. Nevertheless, saving and loading state will change the system orientation 
in the space.  Render is the last option in the menu File. It allows user to render current 
frame as a picture. It is not recommended to change the default values, and in particular the 
file extension (tga is a default). Nevertheless the file name can be changed. New window with 
rendered picture will open and the file will be saved at the working trajectory. 
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Menu Molecule
To  make  all  options  active  a  molecule  in  the 
VMD a molecule should be highlighted. First four 
options:  Mate  top,  Toggle  Active, 
Toggle Displayed and Toggle Fixed are 
also  available  at  the  main  control  window  VMD 
Main. Additionally four other options are avail-
able. Rename allows the user to rename the high-
lighted  molecule.  If  the  trajectory  is  loaded  the 

user can delete some frames using Delete Frames option; it is possible to delete the entire 
trajectory or only a part by specifying  First and  Last frame and the  Stride.  Abort 
File I/O is useful when the user wants to stop loading the trajectory. To delete highlighted 
molecule the option Delete Molecule should be used.   

Menu Graphics
Menu graphics is one of the most frequently used menus in VMD.

1. Representations
It is possible to change the appearance of the protein, visualize the backbone pattern, highlight 
the most important part, use other colors etc. To do that chose Main menu → Graphics 
→ Representations. A new window called Graphical Representations will 
open (Fig. 5). The default representation shows all by lines colored by the default. 

The default colors are:
white for hydrogen
red for oxygen
blue for nitrogen
cyan for carbon
yellow for sulfur and chlorine

Note that the default representation is highlighted. Double click will switch off the representa-
tion. To switch on – again double click.

New representation (Graphical Representations menu)
To create  new representation click the  button  Create Rep.  To remove (delete)  chosen 
(highlighted) representation click the button  Delete Rep. New representation by default 
shows everything (all) as lines by the default. To change the selection give new selection in 
the Selected Atoms field. If more than one molecule is loaded it is possible to select for 
which molecule the user wish to change the representation by changing the field Selected 
Molecule. Please note that molecules IDs are the same as in VMD Main menu.
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Figure 5.Graphical Representations dialog window. 

Selections (Graphical Representations menu)
all – shows all
resname ARG – will show all arginine residues
resid 1 – will show all residues number 1
protein – will show only the protein atoms
water – will show only water atoms
all not protein – will show everything except the protein
all not water – will show everything except water
segname ION – will show only atoms from the segment called ION
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protein and resid 1 – will show only residue 1 from the protein. Note that numbering 
residues in each segments is independent, e.g. there is residue1 in segment protein, residue 1  
in segment water, residue 1 in segment ION, ect. Only atom index is unique.
index 10 – will show only the atom number 10
resid 1 5 9 – will show residues number 1, 5 and 9
resid from 1 to 9 – will show resideus: 1, 2, 3, 4, 5, 6, 7, 8 and 9
index 1 5 9 – will show atoms number 1, 5 and 9
index from 1 to 9 – will show atoms number 1, 2, 3, 4, 5, 6, 7, 8 and 9
resname CYS and resid 1 – will show residue CYS and all residues number 1
all within 10 of protein – will show all atoms in 10Å radius from the protein
all within 10 of protein and resid 4 – will show all atoms in  10Å radius 
from protein residue number 4
all water within 10 of protein and resid 4 – will show all water atoms in 
10Å radius from protein residue number 4
all water within 10 of protein and resid from 4 to 8 – will show all 
water atoms in 10Å radius from protein residues 4, 5, 6, 7 and 8. Note that it is possible to use 
index in the same way as resid

It is possible to give the selection by using the Selections menu. So far we have used the 
Draw style menu (it is the default). In the Selections menu the user can find more selec-
tions possibilities. 

If selections type “all within …. “ are used they will work only for the current frame. There-
fore if the trajectory is loaded and if the user wants to upgrade the selection for each frame in  
the  trajectory:  go  to  Trajectory menu  and  click  Upgrade Selection Every 
Frame. It will work only for the highlighted selection.

Drawing Method (Graphical Representations menu)
To change the drawing method chose other option under Drawing Method menu. 
The most useful methods are: 

• Lines (everything is represented by lines). It is possible to change the line thickness.
• Bonds (everything is represented by bonds). The user can change bond radius and 

bond resolution
• Hbonds (only hydrogen bonds are drawn). The user can change Distance and Angle 

Cutoff (default values are 3Å and 200, respectively) as well as the line thickness
• Points (everything is represented by points, no bonds are drawn). The point size can 

be changed.
• VDW (atoms are drawn as van der Waals spheres). Sphere size and resolution can be 

changed.
• CPK (atoms are represented as CPKs and bonds are drawn as lines). Sphere size and 

resolution as well as bond size and resolution can be changed. 
• Licorice (structure is represented by a licorice). Sphere resolution ans well as bond 

radius and resolution can be changed.
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• NewCartoon (only protein backbone is shown and secondary structure elements are 
visible: α-helices indicated by helix, β-sheets are indicated by arrows). Line thickness 
and resolution can be changed. Changing the Aspect ratio is not recommended.

• Surface (only the surface is drawn). Surface representation method can be changed 
from solid to wireframe. Changing the probe radius is not recommended.

In order to produce a nice picture ensure that the resolution of each representation has been in-
creased. 

Coloring method (Graphical Representations menu)
To change the coloring method select other option under  Coloring Method menu. The 
most useful is coloring by the ColorID – once is selected the new menu appears and the user  
can chose the color. Note colors are denoted by numbers: 0 for blue, 1 for red, ect.  

Material (Graphical Representations menu)
For each drawing method the material can be changed. The default is opaque, other useful op-
tions are:  Transparent  and Glossy.  If  the  Transparent  material  is  used the display  quality 
sometimes is not very good. To improve this go to Main menu → Display → Render-
mode → GLSL. 

2. Colors
It is possible to change the display colors (but not the representations' colors). To open the  
appropriate dialog box click: Main menu → Graphics → Colors, the  new window 
called  Color Control will open (Fig. 6). Under  Categories the user can chose for 
which category the color should be changed. Then the new color can be chosen from the list 
or user-defined by moving Color Definitions buttons. 

Figure 6.Color Controls dialog window.
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Categories (Color controls menu)
• Background   – allows to change the background color.  BackgroundTop and 

BackgroundBot allow to change the background colors if the gradient display is 
chosen (see below for details)

• Axes – the color of x, y and z axis can be changed as well as labels and origin colors
• Name – the color of atom names can be changed (used in  Graphical Repres-

entation when the coloring method Name is selected. The same is possible for se-
lections:  Type,  Element,  Resname,  Restype,  Chain,  SegName, 
Conformation, Molecule, Structure).

• Labels – allows to change the label color of  Atoms, Bonds, Angles, Di-
hedrals and Springs.

 
Note: before producing the figure the good practice is to change the background color to 
white, then the axes labels to black. Changing the atom, bonds and angles label color is worth 
to consider as well. 

3. Materials
It allows user to change the materials definition. To open this dialog box click:  Main menu 
→ Graphics → Materials (Fig. 7). Navigation under Materials dialog box is self-ex-
planatory. 

Figure 7. Materials dialog window.
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4. Labels
By clicking: Main menu → Graphics → Labels  a new dialog box  called Labels 
will open (Fig. 8). It allows the user to work on atoms, bonds and angles labels as well as to 
save plots. To work with Labels first some atoms, bonds and angles should be selected in the 
VMD OpenGL window as described before. In the scroll-down menu the user can choose the 
label  to  work,  the  default  is  Atom,  others  are:  Bonds, Angles, Dihedrals and 
Springs. 

Figure 8. Labels dialog window.

Atoms
The list of picked atoms is available at the navigation window. Once any label is selected the 
user can show, hide or delete the label by clicking on Show, Hide or Delete buttons. The 
information about the picked atom is also given (Picked Atom sub-menu): the molecule to 
which the atom belongs to, the (x,  y,  z) coordinates, residue name (ResName) to which the 
atom belongs to,  residue ID (ResID),  Chain (Chain),  segment  name (SegName),  atom 
name (Name), atom type (Type), index (Index). This information is also available form 
vmd console window. Finally, the value (Value) is also given. Note that for atoms the value is 
always 0.000. By clicking the tab  Graph the user can see and save the plot (Graph and 
Save buttons). Note that for atoms nothing will happen – there is no plot because the value is 
0.000. By clicking the tab Properties the user can change Text Size. Unfortunately it 
will change the size of all labels. The position of the chosen label can be also changed by 
changing the Offset. Finally, the format of the label can be changed (Format window). By 
the default the value of this window is: %R%d:%a. It means that the reside name (%R), residue 
ID (%d) and the atom type (%a) followed by colon (:) is shown. The user can delete the part of 
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the label or the entire label and type his own text here. It will work only for the selected atom 
label. 

Bonds, Angles, Dihedrals and Springs
The menu options are very similar to the Atom options, the only difference is that the value is 
not 0.000 and it is possible to see and save the plot. Note that the plot will be empty if the tra-
jectory is not loaded, what is obvious. For only one frame there is only one value. If the tra-
jectory is loaded the value can change in each frame and the plot: value versus Frame can be  
drawn. 

Menu Display
Menu Display (Main menu → Display) 
allows  user  to  control  the  display  of  the  mo-
lecule  and  affects  the  appearance  of  the  mo-
lecule displayed at the VMD OpenGL window. 

If the user played a lot with the orientation of the 
molecule and then would like to come back to 

the initial view (sometimes the molecule can even disappear from the VMD OpenGL window
), should chose Reset View option (Main menu → Display → Reset View). The op-
tion  Stop Rotation will obviously stop the rotation at the VMD OpenGL window. By 
clicking Perspective or Orthographic the user can change the view of the molecule 
from perspective to orthographic on and reverse (perspective view is a default one but not re-
commended). Moreover it is possible to switch on/off Antialiasing,  Depth Cueing, 
Culling and FPS Indicator. It is not recommended to change the default values expect 
the depth cueing – it allows the user to see what is closer and farther to the screen. The user  
can also switch on/off some lights (Light 0, 1, 2, 3). By the default Light 0 and Light 
1 are on.  The next option – Axes gives the control on axes, which can be switched on or off, 
displayed at the origin, lower left or right, upper left or right. The background is displayed by 
the default as a solid color. The control on this is given by Background. Once the gradient 
display is chosen (Gradient) the user can change the default gradient colors (blue and black
) by  Main menu → Graphics → Colors → Display → Background as de-
scribed above. Changes in Stage are not recommended. If the user would like to produce the 
stereo figure or uses stereo glasses the control on the stereo view is given by the Stereo op-
tion. Switching on the Cachemode is not recommended, the default value is off. The Ren-
dermode is by the default Normal, change in the render mode can slow down the VMD. If 
the user uses transparent representation and is going to render the figure the Rendermode 
should be changed to GLSL which gives the best quality picture but slows down VMD. The 
last option is Display Settings. It allows the user to change the near and far clip, screen 
size and distance or the cue type and its density, nevertheless this control is not very useful. 
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Menu Mouse
Under menu mouse (Main menu → Mouse) 
the user can change the mouse mode from the 
default  rotate  (Rotate Mode)  to  translate 
(Translate Mode) or scale (Scale Mode
). Other two options are: center (Center) and 
query  (Query).  If  the  Query  is  on  and  any 
atom is picked at the  VMD OpenGL window 
noting  will  appear.  The  information  about 

picked atom will be visible only at the vmd console window. Option Label allows to add 
labels to atoms, bonds, angles and dihedrals as it was described above using shortcuts (1, 2, 3  
and 4, respectively). 

Last  four options in the menu Mouse allow the user to play with the molecule. It is not re-
commended to use them for scientific purposes. The user can manually move selected atom, 
residue, fragment, molecule or representations (Main menu → Mouse → Move), manu-
ally add the force to atom, residue or fragment (Main menu → Mouse → Force) move 
the light (Main menu → Mouse → Move Light) and add or remove bonds between se-
lected atoms (Main menu → Mouse → Add/Remove Bonds). 

Menu Extensions
Menu extensions is dedicated for more experi-
enced users which are going to use VMD not 
only for visualisation but also to analyze the ex-
isting MD trajectory and to prepare a new one. 

1. Analysis
APBS Electrostatics allows the user to calculate electrostatic potential or solvent ac-
cessibility bun only when the apbs binary file for the loaded molecule is accessible.

Contact Map allows the user to calculate distance map between residues within the same 
or between two molecules. The map is calculate4d for the current frame only.  

It is not recommended to use MultiSeq option – vmd can crash and the information given 
by this option is not very valuable.
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NAMD Energy can calculate the energy of the molecule using NAMD. The usage is quite 
complicated, therefore this option is not found to be very useful. 

NAMD Plot allows the user to plot information stored in the trajectory output file (*.out not 
*dcd). Since the NAMD output format is not very straightforward to plot energies “by hand” 
this option can be very useful. All kinds of energy stored in the output file might be plotted 
versus time step (TS). First in the NAMD plot window, under the File tab the output file has 
to be selected, then the user can chose the energy to be plotted and than the plot can be made 
by clicking Plot Selected Data in the File tab. The new window with the plot will open, the 
user can save the plot by exporting as a postscript (new *.ps file will be created in the back-
ground) or exporting to xmgrace program (the *agr file will be created and xmgrace will open
). 

PME Electrostatics allows to calculate the PME potential for the current frame. The 
result will be displayed at the VMD OpenGL window as a new molecule.

Radial Pair Distribution Function g(r) allows to calculate g(r) for two giv-
en selections. g(r) shows the density of atoms around the picked atom in the function of the 
distance. The Selection 1 specifies from which atom or atoms g(r) will be calculated. The Se-
lection 2 specifies which types of atoms will we shown in computed g(r). For example if the 
Selection 1 will be protien and Selection 2 will be all, the g(r) plot will be calculated for all  
protein atoms and all atoms will be included. If the selection 2 will be CA only those atoms 
will be included in the g(r) plot. Before computing g(r) go to utilities and set unit cell dimen-
sions – Lengths a, b and c should be the same as in *SC* file. Once the g(f) plot is generated 
it can be exported as a postscript image or agr file.

IR Spectra Calculator in theory should allow to calculate IR spectra. Does not seem 
to work correctly. 

Ramachandran Plot allows to produce a Ramachandran plot for any molecule loaded. 
The white area on the plot correspond to disallowed conformations, the blue area represents 
conformations allowed and classified as α-helix or β-sheets, while green are represents all oth-
er conformations. If the trajectory is loaded the Ramachandran plot will be upgraded for each 
frame automatically. The plot can be saved as a postscript file. 

RMSD Calculator allows to calculate RMSD between all molecules in the memory or 
only active molecules. The selections for which RMSD is calculated can be freely changed. It 
is recommended to click Align button and then RMSD. The RMSD will be calculated for cur-
rent frame only.

RMSD Trajectory Tool can be used to calculate the RMSD for the entire trajectory. 
The other option (preferred one) is to use tcl script (see below)

Salt Bridges  this option allows the user to find salt bridges in the structure. 

Sequence Viewer shows the secondary structure of the protein 
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Timeline does not seem to be useful option

VolMap Tool will calculate the volume of the protein and will display the result ar VMD 
OpenGL window

2. BioCoRE
The user has to login the user to register at VMD web. 

3. Data
The menu is self-explanatory and allows the user to work with connection to Protein Data  
Bank (PDB).
 

4. Modeling
This menu allows to add ions to the structure (Add Ions), add the solvation water (Add 
Solvation Box), to build the psf file (Automatic PSF Builder), build the coarse 
grained  model  (CG Builder),  add  the  membrane  (Membrane Builder),  mutate  a 
reside (Mutate Residue) or add new parameters to the force-field expressions (Para-
metrization Tool). Only the first option seems to work correctly. The results were com-
pared to results obtained by using appropriate scripts. Some of options requires additional lib-
raries to be loaded what can be problematic. Most of above actions can be obtained in other 
ways, therefore only Add Ions is recommended to use.

5. Simulation
This menu does not seem to be useful. The jobs can be ran from the terminal what allows for 
better control of the job progress. Maybe is useful for Windows users?

6. Visualisation
At this menu only 2 sub-menus seem to be useful. 

Dipole moment
Dipole Moment Watcher allows to draw the dipole moment for the given selection. The 
dipole  moment is  drawn at  VMD OpenGL window and upgraded  each  trajectory  frame. 
Moreover, results can be saved to the file containing frame number, x, y,z coordinates and the 
value. 

Making the movie
to make the movie (*.avi file or animated gif) the Movie Maker should be chosen. It allows 
to make movie from the trajectory, as well as containing only the rotation of the structure. To 
make the *avi file displayable at Windows ensure that the VMD OpenGL window has dimen-
sions 640x480 (or double). Then at VMD Movie Generator dialog window at tab Movie 
Settings chose Trajectory (if the user wants to make the movie containing the traject-
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ory only), and unselect Delete image files.  Specify the Trajectory step size 
(it can be understood as stride) and the working directory by clicking Set working dir-
ectory. Finally click Make Movie button at the left bottom corner and … wait. Once all 
snapshots are rendered and saved in the disk opent the terminal shell and:

1) to change the file types type:
for l in *.ppm; do echo $l; convert $l $l.png; done

2) to make make the avi file type:
mencoder “mf://*.png” -mf fps=2 -o output.avi -ovc lavc 
-lavcopts vcodec=mpeg4:vbitrate=4000:autoaspect

3) to see the movie type:
mplayer -vo -x11 output.avi

Note: fps parameter has to be 2, othervise the movie will not play under Windows 
(will play on Linux)

7. Tk Console
Tk Console (Fig. 9) allows to use some tcl scripts and for example to solvate the molecule. 

Figure 9. Tk Console dialog window.

Solvation
The commend typed at the Tk console:
solvate name.psf name.pdb -t 6 -o name_S

will add the solvation box to given molecule, the distance between any protein atom and the 
end of the box will be 6  Å (-t 6) and the output prefix will be name_S (-o)
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solvate name.psf name.pdb -x 1.0 +x 2.0 -y 3.0 +y 4.0 -z 5.0 +z 
6.0 -o name_S
will add the solvation box to given molecule, the box will extend from any protein atom by 1 
Å in -x direction, 2 Åin +x direction, 3 Å in -y direction, and so on. 

Tcl programs
The tcl procedure (rms_ca.tcl) allowing to create RMSD distances can be downloaded from 
vmd web. At the TK console type

play rms_ca.tcl
it will load the tcl program to vmd. Then type:

rmsdt_ca
The RMSD will be created and the rms_ca.dat file will be created in background. To change 
the atom selection or the output file (rms_ca.dat) name the user should modify the rms_ca.tcl 
file. 

The usage of tcl programs downloaded from the vmd Web is always explained within the tcl 
file. 

Menu Help
If  the computer is connected to the Internet it 
will open the manual or tutorial remotely.  
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